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خواص و رویدادهاي مختلف هر آیتم انتخاب شده اعم از فرم ، فایل ، پروژه و کنترل را نشان می  ،(Properties) پنجره خواص
در  . دکنی آنرا ظاهر  F4یا کلید میانبر  View > Properties Windowمی توانید از مسیر  ،اگر این پنجره مخفی است . دده

به عنوان مثال  . دخاصیت ها ، ویژگیها و صفات اشیا را نشان می دهن . دمورد خواص در درسهاي آینده مفصل توضیح خواهیم دا
اگر یک فرم یا کنترل را در صفحه طراحی و یا یک پروژه یا  . تیک ماشین داراي خواصی مانند رنگ ، سرعت، اندازه و مدل اس

این پنجره همچنین داراي  . دانتخاب کنید پنجره خواص مربوط به آنها نمایش داده خواهد ش  SolutionExplorerفایل را در
اتفاقی است که در شرایط خاصی پیش می آید  (event) یک رویداد . درویدادهاي مربوط به فرم یا کنترل انتخاب شده می باش

 کمبو باکس . ماصلاح می کنی (text box) داخل جعبه متنکلیک و یا متنی را در  (button) مانند وقتی که بر روي دکمه
(combo box) شکل بالا که با حرفA  را )…دکمه، فرم و(مورد نظرتان شیء  نشان داده شده است به شما اجازه می دهد که

وچک یا به هم است که کنترلهاي روي فرم بسیار ک این کار زمانی مفید . دکه می خواهید خواص آنرا تغییر دهید انتخاب کنی
برخی از این دکمه ها در  .(B) در زیر کمبو باکس بالا دکمه هاي مفیدي قرار دارند . دنزدیک بوده و انتخاب آنها سخت باش

دومین دکمه خواص را بر  . ددکمه اول خاصیت اشیا را بر اساس دسته هاي مختلفی مرتب می کن. دشرایط خاصی فعال می شون
 . دکند که پیشنهاد می کنیم از این دکمه براي دسترسی سریع به خاصیت مورد نظرتان استفاده کنی اساس حروف الفبا مرتب می

این دکمه به شما اجازه  . مسومین دکمه هم وقتی ظاهر می شود که یک کنترل یا یک فرم را در محیط طراحی انتخاب کنی
) که به شکل یک رعد و برق نمایش داده شده(کمه چهارمین د . ددسترسی به خواص فرم ویا کنترل انتخاب شده را می ده

در پایین شکل بالا توضیحات کوتاهی در مورد خاصیت ها و رویداد ها نشان  . درویدادهاي فرم ویا کنترل انتخاب شده را می ده
و در در ستون سمت چپ نام رویداد یا خاصیت . تشامل خواص و رویدادها اس(C) بخش اصلی پنجره خواص . دداده می شو

قرار دارد که توضیحاتی درباره خواص و  (D) در پایین پنجره خواص جعبه توضیحات . تستون سمت راست مقدار آنها آمده اس
 . درویدادها در آن نمایش داده می شو

 

  استودیوتغییر ظاهر ویژوال 
انید به دلخواه آن را تغییر را دوست نداشته باشید، می تو استودیو اگر موقعیت پنجره ها و یا ظاهر برنامه ویژوال 

کلیک کرده و آنرا می کشید تا پنجره به شکل زیر به حالت شناور  (title bar) براي این کار بر روي نوار عنوان . ددهی
 : در آید
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ظاهر می شود و ) فلشی با چهار جهت(در حالی که هنوز بر روي پنجره کلیک کرده اید و آن را می کشید یک راهنما 

به عنوان مثال شما می توانید پنجره را در بالاترین قسمت  . ددر قرار دادن پنجره در محل دلخواه کمک می کنشما را 
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 :منطقه اي که پنجره قرار است در آنجا قرار بگیرد به رنگ آبی در می آید . دمحیط برنامه قرار دهی
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. 
  

شکل حاوي جعبه هاي مختلفی است که به شما راهنماي صلیب  . تپنجره در قسمت بالاي محیط قرار داده شده اس
به عنوان مثال پنجره  . دقرار دهی استودیواجازه می دهد پنجره انتخاب شده را در محل دلخواه محیط ویژوال 

Properties   ،را انتخاب کنید و آنرا به چپ ترین قسمت صلیب در پنجره نمایش داده شده نزدیک و رها کنید
 : قرار می گیرد  Design Viewره مذکور در سمت چپ پنجره مشاهده می کنید که پنج
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توانید به  میکشیدن پنجره به مرکز صلیب راهنما باعث ترکیب آن با پنجره مقصد می شود که در مثال بالا شما 
 . ددست پیدا کنی  Propertiesعنوان یک تب به پنجره 
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بکشید، یک صلیب راهنماي دیگر نشان   Solution Explorer را روي پنجره  Propertiesبه عنوان مثال پنجره  اگر
قرار   Solution Explorerزیر پنجره   Propertiesپنجره  ،با کشیدن پنجره به قسمت پایینی صلیب . دداده می شو
 . تخواهد گرف
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وال سی شارپ همچنین ویژ . دقسمتی از محیط برنامه که می خواهید پنجره در آنجا قرار بگیرد به رنگ آبی در می آی
هر پنجره داراي یک  . داست که به صورت اتوماتیک پنجره ها را مخفی می کن  autohideداراي خصوصیتی به نام 

  . دمی باش  closeآیکون سنجاق مانند نزدیک دکمه 
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ها می توان با براي دسترسی به هر یک از پنجره  . دفعال شو  auto-hideبر روي این آیکون کلیک کنید تا ویژگی 
  . دکلیک کر استودیووس بر روي آنها توقف یا بر روي تب هاي کنار محیط ویژوال ام

 

 
  

براي غیر فعال کردن این ویژگی در هر کدام از پنجره ها کافیست پنجره را انتخاب کرده و دوباره بر روي آیکون مورد 
 . دنظر کلیک کنی
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افقی بود بدین معناست که ویژگی فعال و اگر شکل آن عمودي بود به  به این نکته توجه کنید که اگر شکل آیکون

 . دمی باش  auto-hideمعناي غیر فعال بود ویژگی 

  

  ساخت یک برنامه ساده
در . داین برنامه یک پیغام را در محیط کنسول نمایش می ده. ماجازه بدهید یک برنامه بسیار ساده به زبان سی شارپ بنویسی

 Visual Studio Community برنامه . مم ساختار و دستور زبان یک برنامه ساده سی شارپ را توضیح دهاین درس می خواه
حال با یک صفحه مواجه می شوید که از شما می  . دیک پروژه جدید ایجاد کنی  File > New Projectاز مسیر  . درا اجرا کنی

  : )زیرشکل (خواهد نام پروژه تان را انتخاب و آن را ایجاد کنید



      www.w3-farsi.comیونس ابراهیمی                   :تالیف و ترجمه                               مبانی زبان سی شارپ

       
 

40 
 

 

 
  

 Consoleیک  . دبگذاری  MyFirstProgramرا انتخاب کنید و نام پروزه تان را  Console Applicationگزینه 
Application  بهتر است برنامه خود را در محیط  . دبرنامه اي تحت داس در محیط وینوز است و فاقد محیط گرافیکی می باش

برنامه نویسی در  بعد از اینکه آموزش مبانی زبان به پایان رسید، . دنویسی آشنا شوی کنسول بنویسید تا بیشتر با مفهوم برنامه
در   solutionیک ویژوال استودیو،  OKبعد از فشردن دکمه  . دمحیط ویندوز و بخش بصري سی شارپ را آموزش خواهیم دا

 . ددر بیشتر تمرینات شامل یک پروژه می باشپروژه هاست ،اما مجموعه اي از   solutionیک. دیک فولدر موقتی ایجاد می کن
پروژه جدید  . دو شامل جزییاتی در مورد پروژه ها و فایلهاي وابسته به آن می باش بوده  slnداراي پسوند   solutionفایل

به آن می می باشد که آن نیز شامل جزییاتی در مورد پروژه ها و فایلهاي وابسته   csproj.همچنین حاوي یک فایل با پسوند 
  . محال می خواهیم شما را با محیط کد نویسی آشنا کنی . دباش

  



      www.w3-farsi.comیونس ابراهیمی                   :تالیف و ترجمه                               مبانی زبان سی شارپ

       
 

41 
 

 

 
کدها در محیط کدنویسی به صورت رنگی تایپ می شوند در . ممحیط کدنویسی جایی است که ما کدها را در آن تایپ می کنی

منوي  اي که ایجاد کرده اید، نام پروژه) 1شماره (شامل منوي سمت چپ . دنتیجه تشخیص بخشهاي مختلف کد را راحت می کن
شامل اعضاي کلاسها )3شماره (و منوي سمت راست …شامل لیست کلاسها ،ساختارها ، انواع شمارشی و) 2شماره ( وسط

 . دتوضیح خواهم دا نگران اصطلاحاتی که به کار بردیم نباشید آنها را در فصول بعد. دمی باش …و ،ساختارها ، انواع شمارشی
در محل کد نویسی کدهایی از قبل نوشته شده که براي شروع  . دهستن cs.اراي کد در سی شارپ داراي پسوند همه فایلهاي د

 : شما آنها را پاك کنید و کدهاي زیر را در محل کدنویسی بنویسید
 

namespace MyFirstProgram 
{ 
    class Program 
    { 
        static void Main() 
        { 
            System.Console.WriteLine("Welcome to Visual C# Tutorials!"); 
        } 
    } 
} 
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  ساختار یک برنامه در سی شارپ

هدف در مثال بالا نمایش یک پیغام در صفحه  . دمثال بالا ساده ترین برنامه اي است که شما می توانید در سی شارپ بنویسی
   . مط کد را در مثال بالا توضیح بدهیخاجازه بدهید هر  . تداراي قواعدي براي کدنویسی اسهر زبان برنامه نویسی . تنمایش اس

تعریف شده است که شامل کدهاي نوشته شده توسط شما است و از تداخل نامها جلوگیري ) namespace(فضاي نام  1در خط 
  . ددر باره فضاي نام در درسهاي آینده توضیح خواهیم دا. دمی کن

سی شارپ یک زبان ساخت یافته است . دآکولاد براي تعریف یک بلوك کد به کار می رو. تنوشته شده اس) } ( آکولاد  2در خط 
نیز ) { ( در سی شارپ باید داراي یک آکولاد بسته )  }( هر آکولاد باز. دکه شامل کدهاي زیاد و ساختارهاي فراوانی می باش

  . تیک بلوك کد یا بدنه فضاي نام اس 10ط تا خ 2همه کدهاي نوشته شده از خط . دباش

در مثال  بالا کدهاي شما باید در . ددر باره کلاسها در فصلهاي آینده توضیح خواهیم دا. تیک کلاس تعریف شده اس 3در خط 
  . دمی باش 9تا  4بدنه کلاس شامل کد هاي نوشته شده از خط . دداخل یک کلاس نوشته شو

هر متد شامل یک سري کد است که وقتی اجرا می شوند که متد را صدا  . تتعریف شده اسلی یا متد اص Mainمتد  5خط در 
این بدان . تنقطه آغاز اجراي برنامه اس Mainمتد . ددرباره متد و نحوه  صدا زدن  آن در فصول بعدي توضیح خواهیم دا . مبزنی

در فصول بعدي توضیح  Mainدر باره متد . دا می شوو سپس بقیه کدها اجر Mainمعناست که ابتدا تمام کدهاي داخل متد 
و سایر متدها داراي آکولاد و کدهایی در داخل آنها می باشند و وقتی کدها اجرا می شوند که متدها را  Mainمتد . دخواهیم دا

شود برنامه با  اگر سیمیکولن در آخر خط فراموش . دختم می شو)  ;( هر خط کد در سی شارپ به یک سیمیکولن  . مصدا بزنی
  :مثالی از یک خط کد در سی شارپ به صورت زیر است  . دخطا مواجه می شو

System.Console.WriteLine("Welcome to Visual C# Tutorials!"); 

براي  ()WriteLineاز متد . درا در صفحه نمایش نشان می ده !Welcome to Visual C# Tutorialsاین خط کد پیغام 
مانند  . تمحصور شده اس) “(یک رشته گروهی از کاراکترها است که به وسیله دابل کوتیشن  . داستفاده می شو چاپ یک رشته

:"Welcome to Visual C# Tutorials!" . نحوه   ،در کل مثال بالا. دباش... ک حرف،عدد، علامت یا تواند ی یک کاراکتر  می
به نوبه خود در داخل فضاي نام  که آن نیز Console که در داخل کلاس ،است WriteLineاستفاده از متد 

MyFirstProgram سی شارپ فضاي خالی و  . تتوضیحات بیشتر در درسهاي آینده آمده اس . دقرار دارد را نشان می ده
اشکال زدایی  اما اینکار خواندن و . دویسیوانید همه برنامه را در یک خط بنبنابراین شما می ت . دخطوط جدید را نادیده می گیر

به مثال  . تیکی از خطاهاي معمول در برنامه نویسی فراموش کردن سیمیکولن در پایان هر خط کد اس . دبرنامه را مشکل می کن
  :زیر توجه کنید 

System.Console.WriteLine( 
"Welcome to Visual C# Tutorials!"); 

  :اما از کد زیر ایراد می گیرد  . دگیر لا اشکال نمیسی شارپ فضاي خالی بالا را نادیده می گیرد و از کد با

System.Console.WriteLine( ; 
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"Welcome to Visual C# Tutorials!"); 

چون دو خط کد مربوط به یک برنامه هستند و  ،برنامه با خطاي نحوي مواجه می شود . دبه سیمیکولن آخر خط اول توجه کنی
همیشه به یاد داشته باشید که سی شارپ به بزرگی و کوچکی حروف  . دآن قرار دهیشما فقط باید یک سیمیکولن در آخر 

رشته ها و توضیحات از این قاعده مستثنی  . ددر سی شارپ با هم فرق دارن manو  MANیعنی به طور مثال . تحساس اس
  :و اجرا نمی شوند  مثلا کدهاي زیر با خطا مواجه می شوند . دهستند که در درسهاي آینده توضیخ خواهیم دا

system.console.writeline("Welcome to Visual C# Tutorials!"); 
SYSTEM.CONSOLE.WRITELINE("Welcome to Visual C# Tutorials!"); 
sYsTem.cONsoLe.wRItelIne("Welcome to Visual C# Tutorials!"); 

  :اما کد زیر کاملا بدون خطا است  . دکنتغییر در بزرگی و کوچکی حروف از اجراي کدها جلوگیري می 

System.Console.WriteLine("WELCOME TO VISUAL C# TUTORIALS!"); 

  . دهمیشه کدهاي خود را در داخل آکولاد بنویسی

{ 
   statement1; 
} 

گیهاي مهم سی شارپ یکی از ویژ . داین کار باعث می شود که کدنویسی شما بهتر به چشم بیاید و تشخیص خطاها راحت تر باش
بدین معنی که کدها را به صورت تو رفتگی از هم تفکیک می کند و این در خوانایی  . تنشان دادن کدها به صورت تو رفتگی اس

  . تبرنامه بسیار موثر اس

  

  ذخیره پروژه و برنامه

 . داستفاده کنی Ctrl+Shift+Sمیانبر بروید یا از کلیدهاي  File > Save Allبراي ذخیره پروژه و برنامه می توانید به مسیر 
 . دکلیک کنیبر روي شکل  Toolbarهمچنین می توانید از قسمت 

 . داستفاده کنی Ctrl+Sبروید یا از کلیدهاي میانبر  File > Save (FileName)براي ذخیره یک فایل ساده می توانید به مسیر 
 . دکنیکلیک بر روي شکل  Toolbarهمچنین می توانید از قسمت 

کلیک  toolbarدر را انتخاب می کنید یا بر روي آیکون   Openگزینه  Fileبراي باز کردن یک پروژه یا برنامه از منوي 
  . درا باز می کنی  csproj.یا پروژه با پسوند  slnسپس به محلی که پروژه در آنجا ذخیره شده میروید و فایلی با پسوند . دکنی
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 کامپایل برنامه

براي کامپایل  . دد ذکر شد که کدهاي ما قبل از اینکه آنها را اجرا کنیم ابتدا به زبان میانی مایکروسافت ترجمه می شونقبلا یا
این  . مرا بر روي صفحه کلید فشار می دهی  F6را انتخاب می کنید یا دکمه   Build Solutionگزینه   Debugبرنامه از منوي 

می  Solution Explorerبه   solutionبراي کامپایل یک قسمت از  . درا کامپایل میکن  solutionکار همه پروژه هاي داخل 
  : مانند شکل زیر . درا انتخاب می کنی  buildرویم و بر روي آن قسمت راست کلیک کرده و از منوي باز شوند گزینه

 

 

  

  

  

  

  اجراي برنامه

دو . دوماتیک کدهاي ما را به زبان میانی مایکروسافت کامپایل می کنوقتی ما برنامه مان را اجرا می کنیم سی شارپ به صورت ات
  :راه براي اجراي برنامه وجود دارد 

 )Debug(اجرا همراه با اشکال زدایی 

 )Non-Debug(اجرا بدون اشکال زدایی 
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سریعا برنامه اجرا   Non-Debugبا اجراي برنامه در حالت . داجراي بدون اشکال زدایی برنامه، خطاهاي برنامه را نادیده می گیر
مخفی است و براي استفاده  Non-Debugدر حالت پیش فرض حالت . دمی شود و شما با زدن یک دکمه از برنامه خارج می شوی

استفاده  Crl + F5را انتخاب کرد یا از دکمه هاي ترکیبی  Start Without Debugingگزینه  Debugاز آن می توان از منوي 
  :نمود

Welcome to Visual C# Tutorials! 
Press any key to continue . . . 

جز خروجی به حساب نمی آید و فقط نشان دهنده آن   …Press any key to continueبه این نکته توجه کنید که پیغام 
دسترسی به  . دیاجرا شده است و شما می توانید با زدن یک کلید از برنامه خارج شو  Non-Debugاست که برنامه در حالت 

از این حالت براي رفع خطاها  . دآسان تر است و به صورت پیشفرض برنامه ها در این حالت اجرا می شون  Debug Modeحالت 
 break pointsشما همچنین می توانید از  . دو اشکال زدایی برنامه ها استفاده می شود که در درسهاي آینده توضیح خواهیم دا

می   Debug Modeبراي اجراي برنامه با حالت  . دمه در مواقعی که با خطا مواجه می شوید استفاده کنیبرنا  Helpو قسمت 
همچنین می توانید بر روي  . درا فشار دهی  F5را انتخاب کرده و یا دکمه  Start Debuggingگزینه   Debugتوانید از منوي 

استفاده کنید برنامه نمایش داده شده و فورا   Debug Modeاگر از حالت  . دکلیلک کنی  toolbarدر شکل 
براي توقف   ()System.Console.ReadKeyبراي جلوگیري از این اتفاق شما می توانید از کلاس و متد  . دناپدید می شو

  ). دم دادرباره متدها در درسهاي آینده توضیح خواهی( . دبرنامه و گرفتن ورودي از کاربر جهت خروج از برنامه استفاده کنی

  

namespace MyFirstProgram 
{ 
    class Program 
    { 
        static void Main() 
        { 
            System.Console.WriteLine("Welcome to Visual C# Tutorials!"); 
            System.Console.ReadKey(); 
        } 
    } 
} 

مشاهده می کنید که برنامه متوقف شده و از شما در خواست ورودي می  . ماجرا می کنی Debug Modeحال برنامه را در حالت 
به این علت استفاده کردم تا نیازي به  Non-Debugمن از حالت  . داز برنامه خارج شوی Enterکند، به سادگی و با زدن دکمه 

-Nonکر شد که برنامه را اجرا کنید برنامه را در حالت از این به بعد هر جا ذ. دنباش ()Console.ReadKeyنوشتن کد اضافی 
Debug ها رسیدیم از حالت وقتی به مبحث استثناء. داجرا کنیDebug حال با خصوصیات و ساختار اولیه  . ماستفاده می کنی

  . تسهاي آینده مطالب بیشتري از این زبان برنامه نویسی قدرتمند خواهید آموخرسی شارپ آشنا شدید در د
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  IntelliSenseاستفاده از 

ما را قادر می سازد که  IntelliSense . دباش) IntelliSense(، اینتل لایسنس   Visual Studioشاید یکی از ویژگیهاي مهم 
   ،وقتی که شما در محیط کدنویسی حرفی را تایپ کنید . مدسترسی پیدا کنی....به سرعت به کلاسها و متدها و

IntelliSenseکد زیرا را در داخل متد  . دمی شو فورا فعالMain دبنویسی .  

System.Console.WriteLine(“Welcome to Visual C# Tutorials!”); 
  

 . دفعال شو IntelliSenseاولین حرف را تایپ کنید تا 

 

IntelliSense  ا می توانید با زدن دکمه شم. دلیستی از کلمات به شما پیشنهاد می دهد که بیشترین تشابه را با نوشته شما دارن
tab  دشما با لیست پیشنهادي دیگري مواجه می شوی ( . ) با تایپ نقطه . دگزینه مورد نظرتان را انتخاب کنی . 

 

اگر بر روي گزینه اي که می خواهید انتخاب کنید لحظه اي مکث کنید توضیحی در رابطه با آن مشاهده خواهید کرد مانند شکل 
 W ،IntelliSenseبراي مثال با تایپ حرف . ده پایان کد نزدیک می شوید لیست پیشنهادي محدود تر می شوهر چه که ب. بالا

 . دهستند را نمایش می ده  Wفقط کلماتی را که داراي حرف
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 . دبا تایپ حرف هاي بیشتر لیست محدودتر شده و فقط دو کلمه را نشان می ده

 

براي ظاهر کردن  . دشما تایپ کرده اید پیدا کند هیچ چیزي را نمایش نمی ده نتواند چیزي را که  IntelliSenseاگر 
IntelliSense   کافیست دکمه ترکیبیCtrl+Space براي انتخاب یکی از متدهایی که داراي چند حالت  . درا فشار دهی

 ()Writelineمثلا متد  . دنتخاب کریکی از حالت ها را ا) بالا و پایین(هستند، می توان با استفاده از دکمه هاي مکان نما 
 . تحالت نمایش پیغام در صفحه اس 19همانطور که در شکل زیر مشاهده می کنید داراي 

 

IntelliSense  دبه طور هوشمند کدهایی را به شما پیشنهاد می دهد و در نتیجه زمان نوشتن کد را کاهش می ده . 

  

 رفع خطاها
حداقل از داشتن یک  ،تقریبا همه برنامه هایی که امروزه می بینید . مبا خطا مواجه می شویبیشتر اوقات هنگام برنامه نویسی 

 : در سی شارپ سه نوع خطا وجود دارد. خطا ها می توانند برنامه شما را با مشکل مواجه کنند . دخطا رنج می برن
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 خطاي کامپایلري

این بدین معنی است که . دخطا ها شامل خطاي دستور زبان می باش این . داین نوع خطا از اجراي برنامه شما جلوگیري می کن
یکی دیگر از موارد وقوع این خطا هنگامی است که شما از چیزي استفاده می کنید  . دشما قواعد کد نویسی را رعایت نکرده ای

ست باعث به وجود آمدن خطاي حذف فایلها یا اطلاعات ناقص در مورد پروژه ممکن ا . تکه نه وجود دارد و نه ساخته شده اس
استفاده از برنامه بوسیله برنامه دیگر نیز ممکن است باعث جلوگیري از اجراي برنامه و ایجاد خطاي کامپایلري . دکامپایلري شو

 . دشو

  

 خطاهاي منطقی

سخت است چون شما براي رفع این نوع خطاها بسیار . داین نوع خطا در اثر تغییر در یک منطق موجود در برنامه به وجود می آی
نمونه اي از یک خطاي منطقی برنامه اي است که دو عدد را جمع می کند ولی حاصل تفریق دو . دیافتن آنها باید کد را تست کنی

 . ددر این حالت ممکن ات برنامه نویس علامت ریاضی را اشتباه تایپ کرده باش. دعدد را نشان می ده
  

 استثناء

این خطا هنگامی روي می دهد که کاربر یک ورودي نامعتبر به  . ترخ می دهند که برنامه در حال اجراس این نوع خطاها هنگامی
ویژوال استودیو و ویژوال سی شارپ داراي ابزارهایی براي پیدا کردن و برطرف  . دبرنامه بدهد و برنامه نتواند آن را پردازش کن

ل تایپ کد هستیم یکی از ویژگیهاي ویژوال استودیو تشخیص خطاهاي وقتی در محیط کدنویسی در حا . دکردن خطاها هستن
  . دزیر کدهایی که داراي خطاي کامپایلري هستند خط قرمز کشیده می شو . تممکن قبل از اجراي برنامه اس
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بز هم مواجه شما ممکن است با خط س. دکنی توضیحات خطا را مشاهده می ،وس روي این خطوط توقف کنیداهنگامی که شما با م
به عنوان مثال ممکن است شما یک متغیر . دولی به شما اجازه اجراي برنامه را می دهن ،شوید که نشان دهنده اخطار در کد است

  .)در درس هاي آینده توضیح خواهیم داد( . درا تعریف کنید ولی در طول برنامه از آن استفاده نکنی

 

 
  

 رمز نشان دادهکه در شکل زیر با فلش ق) لیست خطاها( ErrorList . مشتري می دهیدر باره رفع خطاها در آینده توضیح بی
 می توانید به مسیر Error List براي باز کردن  . دشده است به شما امکان مشاهده خطاها ، هشدارها و رفع آنها را می ده

View> Error List  دبروی .  
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نمایش داده می Error List ه برنامه شما با خطا مواجه شود لیست خطاها درهمانطور که در شکل زیر مشاهده می کنید هرگا
  . دشو

 

 
  

داراي چندین ستون  Error List . تنمایش داده شده اس Error List در شکل بالا تعدادي خطا همراه با راه حل رفع آنها در
  . داست که به طور کامل جزییات خطاها را نمایش می دهن
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 توضیحات  ستون 

Description  توضیحی درباره خطا 

File   فایلی که خطا در آن اتفاق افتاده است 

Line   شماره خطی از فایل که داراي خطاست 

Column   ستون یا موقعیت افقی خطا در داخل خط
Project  تنام پروژه اي که داراي خطاس .  

 : پنجره زیر روبرو می شویداگر برنامه شما داراي خطا باشد و آن را اجرا کنید با 

 

دیگر این پنجره به عنوان هشدار  ،زنید چون دفعات بعد که برنامه شما با خطا مواجه شودبمربع کوچک داخل پنجره بالا را تیک 
راي اج NO اما با کلیک بر روي دکمه . دبرنامه با وجود خطا نیز اجرا می شو Yes با کلیک بر رو ي دکمه . دنشان داده نخواهد ش

 یکی دیگر از ویژگیهاي مهم پنجره . درا بر طرف نمایی Error List برنامه متوقف می شود و شما باید خطاهاي موجود در پنجره
Error List  با یک کلیک ساده بر روي هر کدام خطاهاي موجود در . تنشان دادن قسمتی از برنامه است که داراي خطاس

 . دمایش داده می شو، محل وقوع خطا ن Error List پنجره

  

  

  آن کردن برطرف و خطایابی
،جانشین  Sampleکلمه  :و نحوه برطرف کردن آنها آمده است  Error Listدر جدول زیر لیست خطاهاي معمول در پنجره 

  :نامهاي وابسته به خطاهایی است که شما با آنها مواجه می شوید و در کل یک کلمه اختیاري است

 راه حل توضیح خطا

; expected 
قرار نداده ) ;(در پایان دستور علامت سیمیکان 

  اید
اضافه کردن یک 

  );(سیمیکالن 
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 راه حل توضیح خطا

The name ‘sample’ does not exist in the 
current context. 

در کد شما نه تعریف شده و نه  sampleکلمه 
  وجود دارد

را حذف  sampleکلمه 
 . دیا تعریف کنی

Only assignment, call, increment, 
decrement, and new object expressions 

can be used as a statement. 
 دستور را حذف کنید کد جز دستورات سی شارپ نیست

Use of unassigned local variable ‘sample’  متغیرsample مقدار دهی اولیه نشده 
قبل از استفاده از متغیر 
آن را مقدار دهی اولیه 

 کنید

The type or namespace name ‘sample’ 
could not be found (are you missing a 
using directive or an assembly 

reference?) 

تعریف نشده  sampleنوع یا فضاي نام متغیر 
 است

باید یک کلاس یا فضاي 
 sampleنام ،به نام 

  ایجاد کنید

 

‘MyMethod()’: not all code paths return 
a value 

که به  ()MyMethodمعنات که متد  بدین
عنوان متدي با مقدار برگشتی در نظر گرفته 
شده در همه قسمتهاي کد داراي مقدار برگشتی 

 . تنیس

مطمئن شوید که متد در 
همه قسمتهاي کد داراي 

 مقدار برگشتی است

Cannot implicitly convert type ‘type1′ to 
‘type2′ 

تبدیل  type1غیر نمی تواند به مت type2متغیر 
 . دشو

با استفاده از متدهاي 
تبدیل انواع به هم ،دو 

 . دمتغیر را یکسان کنی

  . تنها در درسهاي آینده آمده اسآنگران یادگیري کلمات به کار رفته در جدول بالا نباشید چون توضیح 

  

  توضیحات

و بیشتر (در سی شارپ  . دن کد به آن اضافه کنیوقتی که کدي تایپ می کنید شاید بخواهید که متنی جهت یادآوري وظیفه آ
توضیحات متونی هستند که توسط کامپایلر نادیده  . دمی توان این کار را با استفاده از توضیحات انجام دا) زبانهاي برنامه نویسی

نقش کدهاي  هدف اصلی از ایجاد توضیحات خوانایی و تشخیص . دگرفه می شوند و به عنوان بخشی از کد محسوب نمی شون
فرض کنید که می خواهید در مورد یک کد خاص، توضیح بدهید، می توانید  . تنوشته شده توسط شما ، براي دیگران اس
  . دتوضیحات را در بالاي کد یا کنار آن بنویسی
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    :در برنامه زیر نقش توضیحات نشان داده شده است  . داز توضیحات براي مستند سازي برنامه هم استفاده می شو

namespace CommentsDemo 
{ 
    class Program 
    { 
        public static void Main(string[] args) 
        { 
            // This line will print the message hello world 
            System.Console.WriteLine("Hello World!"); 
        } 
    } 
} 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 

توضحات بر دو نوعند،  توضیحات تک خطی و توضیحات چند   . تنشان داده شده اس) تک خطی(یک توضیح ساده  7در خط 
  :خطی 

// single line comment 
 
/* multi  
   line 
   comment */ 

// ضیحات با علامت این تو . دتوضیحات تک خطی همانگونه که از نامش پیداست براي توضیحاتی در حد یک خط به کار می رون
این نوع توضیحات معمولا در  . دشروع می شوند و هر نوشته اي که در سمت راست آن قرار بگیرد جز توضیحات به حساب می آی

 . داگر توضیح در باره یک کد به بیش از یک خط نیاز باشد از توضیحات چند خطی استفاده می شو . دبالا یا کنار کد قرار می گیرن
هر نوشته اي که بین این دو علامت قرار بگیرد جز توضیحات محسوب  . دپایان می یابن /*شروع  و با  */د خطی با توضیحات چن

از این  . دنشان داده می شون(///) این نوع با سه اسلش  . دنامیده می شون XMLنوع دیگري از توضیحات ، توضیحات  . دمی شو
 . دد و در درس هاي آینده در مورد آنها توضیح خواهیم دانوع براي مستند سازي برنامه استفاده می شو

  

 کاراکترهاي کنترلی

شروع می شوند و به دنبال آنها یک حرف یا عدد می ) \(کاراکترهاي ترکیبی هستند که با یک بک اسلش  ،کاراکترهاي کنترلی
ید و قرار دادن رشته در آن می توان از براي مثال براي ایجاد یک خط جد . دآید و یک رشته را با فرمت خاص نمایش می دهن

  :استفاده کرد  n\کاراکتر کنترلی 

System.Console.WriteLine("Hello\nWorld!"); 
Hello 
World! 
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نشانگر موس را به خط بعد برده و بقیه رشته را در خط بعد نمایش  n\مشاهده کردید که کامپایلر بعد از مواجهه با کاراکتر کنترلی 
یک خط جدید ایجاد می کند ، البته بدین صورت که در انتهاي رشته  n\هم مانند کاراکتر کنترلی  ()WriteLineتد م. دمی ده

  :اضافه می کند  n\یک کاراکتر کنترلی 

System.Console.WriteLine("Hello World!"); 

 :کد بالا و کد زیر هیچ فرقی با هم ندارند 

System.Console.Write("Hello World!\n"); 

دارد با این تفاوت که نشان گر موس را در همان خط نگه می دارد و خط جدید  ()WriteLineکارکردي شبیه به  ()Writeمتد 
  :جدول زیر لیست کاراکترهاي کنترلی و کارکرد آنها را نشان می دهد  . دایجاد نمی کن

 عملکرد کاراکتر کنترلی عملکرد کاراکتر کنترلی

 f Form Feed\ چاپ کوتیشن ’\

 خط جدید n\ چاپ دابل کوتیشن ”\

  سر سطر رفتن r\ چاپ بک اسلش \\
 حرکت به صورت افقی t\  چاپ فضاي خالی 0\

\a صداي بیپ \v 
حرکت به صورت 

 عمودي

\b حرکت به عقب \u چاپ کاراکتر یونیکد 

  

معناي خاصی به رشته ها می دهد براي  \از آنجاییکه  . ماستفاده می کنی) \(ما براي استفاده از کاراکترهاي کنترلی از بک اسلش
 :استفاده کنیم ) \\(باید از ) \(چاپ بک اسلش 

System.Console.WriteLine("We can print a \\ by using the \\\\ escape sequence."); 
We can print a \ by using the \\ escape sequence. 

  :ان دادن مسیر یک فایل در ویندوز است ،نش \\یکی از موارد استفاده از 

System.Console.WriteLine("C:\\Program Files\\Some Directory\\SomeFile.txt"); 
C:\Program Files\Some Directory\SomeFile.txt 

  :می کنیم استفاده \"براي نشان دادن رشته ها استفاده می کنیم براي چاپ آن از ) "(از آنجاییکه از دابل کوتیشن 

System.Console.WriteLine("I said, \"Motivate yourself!\"."); 
I said, "Motivate yourself!". 
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  :استفاده می کنیم  ’\از) ‘(همچنین براي چاپ کوتیشن 

System.Console.WriteLine("The programmer\'s heaven."); 
The programmer's heaven. 

  :استفاده می شود  t\ حروف یا کلمات از براي ایجاد فاصله بین 

System.Console.WriteLine("Left\tRight"); 
Left Right 

  :بیایند به اول سطر منتقل و جایگزین کاراکترهاي موجود می شوند  r\هر تعداد کاراکتر که بعد از کاراکتر کنترلی 

System.Console.WriteLine("Mitten\rK"); 
Kitten 

را به ابتداي سطر برده و جایگزین  Kکاراکتر کنترلی حرف . تآمده اس r\بعد از کاراکتر کنترلی  Kال بالا کاراکتر مثلا در مث
 . دمی کن Mحرف 

کاراکتر را درست بعد از  16،مقدار در مبناي  u\براي استفاده از  . داستفاده کر u\براي چاپ کاراکترهاي یونیکد می توان از 
را قرار  00A9مقدار  u\را چاپ کنیم باید بعد از علامت ) ©(براي مثال اگر بخواهیم علامت کپی رایت . میقرار می ده u\علامت 

  :دهیم مانند 

System.Console.WriteLine("\u00A9"); 
© 

 :براي کاراکترهاي یونیکد به لینک زیر مراجعه نمایید  16براي مشاهده لیست مقادیر مبناي 
http://www.ascii.cl/htmlcodes.htm  

بیشترین خطا زمانی اتفاق می افتد که  . داگر کامپایلر به یک کاراکتر کنترلی غیر مجاز برخورد کند، برنامه پیغام خطا می ده
  . داستفاده می کن \\از ) \(برنامه نویس براي چاپ اسلش 

  

  @ علامت
وقتی از  . دزه می دهد که کاراکترهاي کنترلی را رد کرده و رشته اي خوانا تر و طبیعی تر ایجاد کنیبه شما اجا @علامت 

به جاي استفاده از دو   ) \ (کاراکترهاي کنترلی در یک رشته استفاده می شود ممکن است براي تایپ مثلا یک بک اسلش 
  . داستفاده کرده و دچار اشتباه شوی \از یک  \\علامت 
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ک کاراکتر کنترلی را تایپ ار باعث به وجود آمدن خطاي کامپایلري شده و چون کامپایلر فکر می کند که شما می خواهید یاین ک
به مثال زیر توجه   . درا پردازش می کند و چون کاراکتر کنترلی وجود ندارد خطا به وجود می آی \کاراکتر بعد از  علامت کنید، 
  :کنید 

System.Console.WriteLine("I want to have a cat\dog as a birthday present."); //Error 

براي اثبات گفته بالا )  \( استفاده شود ولی عمدا از بک اسلش  cat/dogدر ( / ) با وجودیکه بهتر است در مثال بالا از اسلش 
 چنینچون  ،قابل تشخیص نیست d\ترلی کامپایلر خطا ایجاد می کند و به شما می گوید که کاراکتر کن . ماستفاده کرده ای

زمانی وضعیت بدتر خواهد شد که کاراکتر بعد از بک اسلش کاراکتري باشد که هم جز یک کلمه  . دکاراکتر کنترلی وجود ندار
  :به مثال زیر توجه کنید  .باشد و هم جز کاراکترهاي کنترلی

System.Console.WriteLine("Answer with yes\no:"); 
Answer with yes 
o 

  
  براي نادیده گرفتن کاراکترهاي کنترلی @استفاده از علامت 

زمانی مناسب است که شما نمی خواهید از علامت بک اسلش براي نشان دادن یک کارکتر کنترلی استفاده  @استفاده از علامت 
  . در آن را قرار دهیاستفاده از این علامت بسیار ساده است و کافی است که قبل از رشته مورد نظ . دکنی

System.Console.WriteLine(@"I want to have a cat\dog as a birthday present."); 
I want to have a cat\dog as a birthday present. 

چون  . دمعمولا زمانی استفاده می شود که شما بخواهید مسیر یک دایرکتوري را به عنوان رشته داشته باشی @از علامت 
  . تبهتر اس) \\(به جاي دابل بک اسلش  @ایرکتوري ها داراي تعداد زیادي بک اسلش هستند و طبیعتا استفاده از علامت د

System.Console.WriteLine(@"C:\Some Directory\SomeFile.txt"); 
C:\Some Directory\SomeFile.txt 

  . داز دو دابل کوتیشن استفاده کنی اگر بخواهید یک دابل کوتیشن چاپ کنید به سادگی می توانید

System.Console.WriteLine(@"Printing ""double quotations""..."); 
Printing "double quotations"... 

کتر کنترلی در خروجی می اران خودداري کنید چون باعث چاپ کاو کاراکترهاي کنترلی به طور همزم @از به کار بردن علامت 
  . دشو

  



      www.w3-farsi.comیونس ابراهیمی                   :تالیف و ترجمه                               مبانی زبان سی شارپ

       
 

57 
 

  براي نگهداري از قالب بندي رشته ها @از علامت  استفاده

عنوان مثال  هب . تاس n\چاپ رشته هاي چند خطی بدون استفاده از کاراکتر کنترلی  @یکی دیگر از موارد استفاده از علامت 
  :براي چاپ پیغام زیر 

C# is a great programming language and 
it allows you to create different 
kinds of applications. 

  :یکی از راه هاي چاپ جمله بالا به صورت زیر است 

Console.WriteLine("C# is a great programming language and\n" + 
"it allows you to create different\n" + 
"kinds of applications.");  

کتر همانطور که قبلا مشاهده کردید خط جدید ایجاد می کند و در این کارا . ددر آخر هر جمله توجه کنی n\به نحوه استفاده از 
راه دیگر  . دهم براي ترکیب رشته ها استفاده می شو+ از علامت  . دمثال بالا باعث می شود که جمله به چند خط تقسیم شو

  است  @براي نمایش مثال بالا در چندین خط استفاده از علامت 

Console.WriteLine(@"C# is a great programming language and 
it allows you to create different 
kinds of applications."); 

  را فشار دهید  Enterدر این حالت کافیست که در هر جا که می خواهید رشته در خط بعد نمایش داده شود دکمه 

 

 متغیرها

می توان آن را به عنوان یک ظرف تصور کرد که . دن ذخیره کنیمتغیر مکانی از حافظه است که شما می توانید مقادیري را در آ
که . تهر متغیر داراي یک نام نیز هس. دمحتویات این ظرف می تواند پاك شود یا تغییر کن. دداده هاي خود را در آن قرار داده ای

همچنین داراي یک مقدار می . درتوان متغیر را از دیگر متغیر ها تشخیص داد و به مقدار آن دسترسی پیدا ک از طریق آن می
متغیر داراي . دمقدار متغیر می تواند تهی نیز باش. دباشد که می تواند توسط کاربر انتخاب شده باشد یا نتیجه یک محاسبه باش

ي متغیر داراي عمر نیز هست که از رو . تنوع نیز هست بدین معنی که نوع آن با نوع داده اي که در آن ذخیره می شود یکی اس
و در نهایت متغیر داراي محدوده استفاده . دآن می توان تشخیص داد که متغیر باید چقدر در طول برنامه مورد استفاده قرار گیر

ما از متغیرها به عنوان یک انبار موقتی . تنیز هست که به شما می گوید که متغیر در چه جاي برنامه براي شما قابل دسترسی اس
هنگامی که یک برنامه ایجاد می کنیم احتیاج به یک مکان براي ذخیره داده ،مقادیر یا داده  . مه می کنیبراي ذخیره داده استفاد

براي این از کلمه متغیر استفاده می شود چون ما می  . تمکان همان متغیر اس نای . مهایی که توسط کاربر وارد می شوند داری
متغیرها موقتی هستند و فقط موقعی مورد استفاده قرار  . مدار آن را تغییر دهیتوانیم بسته به نوع شرایط هر جا که لازم باشد مق


